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BOILERPLATE

“The  Voice  of  FCUG"  is  the  monthly  newsletter  of  the  Fairfield 
County Computer Users Group, Inc., a registered non-profit organization 
dedicated to helping members use their PC computers. Non-commercial 
and non-profit  users  are  free  to copy  or  quote  material  herein;  proper 
credit  and  sending  a  copy  of  the  publication  to  the  Editor  would  be 
appreciated.

Members can exchange ideas and opinions through this newsletter, 
at a monthly meeting held the first Tuesday of most months, at occasional 
SIG programs,  and on a bulletin board reached from the Club Internet 
Web-site at www.fcug.org.

Meetings and SIG groups are open to the public. Membership costs 
$30/Yr, prorated. For information and payment contact

Ed Congleton, Treasurer: 203-966-4854, 
251 Weed Street, New Canaan, CT. 06840

To submit articles or letters for The Voice send an e-mail message to 
wdhart@attglobal.net,  hopefully  with article  attached,  or  mail  paper,  or 
even a diskette in ASCII, Word, or WordPerfect format to: 

The Voice, 280 Main Street, Westport, CT 06880

The Editor's Desk

Had  an  interesting  problem  the 
other  day,  and  devised  a  dangerously 
simple solution...

A friend's XP computer refused to 
open  Firefox.  It  had  also  become  very 
slow.  Registry  cleaning  and  deletion  of 
unnecessary  temporary  files  found  no 
solution to either problem.

Then it was noticed on opening the Task Manager (Ctrl-Alt-Del on 
the desktop)  that  Firefox had opened,  not  among the Applications,  but 
with the system processes. In fact, it was running more than once there, 
and hogging all the facilities. The speed problem was solved by closing all 
the hidden Firefoxes. This also explained why, on closing the system, one 
on occasion saw a message that Firefox was still busy, although it was not 
on the desktop.

Several attempts were made to get it to open properly, and a Web 
exploration was made for solutions. It seemed nobody had noticed Firefox 
running as a process.

Finally, the entire folder at Documents and Settings / [username] / 
Application Data / Mozilla was replaced with that from another user who 
had not had trouble; problem solved, though not properly diagnosed. If 
you know the proper solution, please let me know.

---o-oOo-o---



Program for 28th July 2009
Joint Meeting with the Connecticut PC Users Group (CTPC)  

at Norwalk Hospital.

David  Casceillo  Director,  Client  Support,  in  the  IT  Dept.  will  
review  steps  being  taken  to  implement  electronic  record 
keeping  systems  in  order  to  improve  patient  care.  He  will  
show  how  physicians  and  other  Hospital  personnel  use  
computers  for  instant  access  to  patient  records  when  time is  
of  the essence.  He will  also discuss  the benefits  of  electronic 
medical  records  vs.  hand  written  charts.  In  addition,  we  will  
get a tour and briefing of the server facil it ies in the IT Dept.

The  meeting  will  begin  at  7  PM  in  the  Richard  Perkin  
Auditorium  near  the  Hospital  entrance.  Use  the  visitor  
parking  lot  for  easy  access.  Please  join  us  for  this  
presentation  by  a  very  dynamic,  enthusiastic  member  of  the 
Norwalk Hospital team.

At  the  end  of  the  meeting,  those  who  wish  can  join  us  at  
Uncle  Joe’s  in  Broad  River  (Route  123)  for  Pizza  and 
refreshments.

Meet  at  the  auditorium  inside  the  front  door  of  Norwalk 
Hospital on the left as you enter. 

LOOKIN' FOR A RIDE? 

If anybody who wants to attend 
meetings has a transport problem, 
please mention it and together we 
will look for a solution. You can also 
contact Membership Chairman Lynn 
Bloom (203-380-9306, or 
lennyb2@optonline.net). She can 
tell you who lives near you, or might 
pass by on their way.
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The Way We Were -- 
augusT 1989

 
 President -- Aaron Bisberg
 Vice President -- Herman Parks
 Secretary -- Taylor Vincent
 Treasurer -- Ed Congleton
 Editor -- Alan Abrahamson
 TBBS System Operator -- John Krause

Printed by Technical Reproductions, Inc.

Something for Everyone – Roger Giler. Two pages on Backup, Compression and 
Other Goodies.

Ethics, Morality, Pride – are these lost? – George Saladino. Two pages on paying for 
shareware.

Bill's  Bumblings  No.43  –  Pascal  –  Bill  Hart.  Three  pages  on  Chaos,  including 
program listing.

Your CONFIG.SYS and AUTOEXEC.BAT – Barry Simon.  From Compuserve's  IBM 
Forum, with permission. Eight-plus pages.

Using a Menu Shell – Aaron Bisberg. One-plus pages.

FCUG August 1, 1989 Program
Building Your Own Computer – Spencer Heath.
Shareware Topic: Family Edge – Ed Neyland.
Q&A Director – Tony DiMeglio.

-----ooOoo-----

Because your Reporter was unable to attend the July 
meeting, there will only be a description of the 

proceedings if YOU can email something to the Editor.

Thanks in advance...
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Questions and Answers

From the January 2009 issue of “Bits, PCs and Macs”, the journal of the Sun City  
Anthem Computer Club of Henderson, NV 

[The first question, being concerned with the organization of the Sun City Anthem 
club itself, has been omitted here.]

Question: For several years now, my Windows XP Professional  system has 
had a “Show Desktop” icon in the QuickLaunch area of the toolbar. Recently, 
I have noticed that it is missing. Now that I am aware, I miss it dearly. How 
can I recover this little gem?
Answer: I have found that it is faster for me to simply press and hold the Windows 
logo key and press the letter D on the keyboard. If you still would like to have the 
icon on the quick launch area, follow the instructions on this page: 

http://support.microsoft.com/kb/190355
If you find that keyboard short-cut to your liking, there are many others that
 are applicable to Windows XP here (quite frankly, most apply to Windows Vista)

http://support.microsoft.com/kb/301583

Question: Windows XP Service Pack 3 has been out for some time but I have 
delayed installing it due to the problems associated with it. Has its quality 
improved to where I can now install it?
Answer: Service Pack 3 (SP3) is exactly the same today as when it was released. ….

The following two situations seem to be the major roadblocks to installing 
SP3. Neither point to errors in the Microsoft code.

1. If  you have a  Compaq or  HP desktop computer that  also  has  an AMD 
processor.  Turn  off  Automatic  updates.  If  this  is  too  late,  and  your 
computer has gone bananas, restart in Safe mode by repeatedly pressing 
[the] F8 key on start up. Go to the Control Panel and double-click Add or 
Remove Programs. Select Service Pack and Remove. The computer will be 
restored to the prior condition. Then fix the problem before continuing. A 
former Microsoft Manager offers a free fix for this problem, see the eighth 
bullet item here:

http://tinyurl.com/6zs52d
Please  be  aware,  there  is  free  unlimited  installation  and  compatibility  support 
available for Windows XP, but only for Service Pack 3 (SP3). This support for SP3 is 
valid until April 14, 2009.

http://tinyurl.com/6cw2xk
If  you haven’t  installed SP3,  I  suggest  that  you do so soon or the  support will 
expire. I have successfully used the Individual chat support several times.

2. Symantec users “...should switch off the  "SymProtect" feature before trying 
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to install XP SP3
http://tinyurl.com/5kqw5w 

Personally, I would replace the Symantec software with either AVG or Avast. Both 
have free versions.

AVG: http://tinyurl.com/4mw3vt. Scroll down and click on the Download 
button at the left bottom of the three columns.

Avast: http://tinyurl.com/8z9h5

Question: I spend a lot of time on the QuickBooks forums assisting others 
with problems using the product. When I am using the Firefox browser and 
type the word QuickBooks, it is always shown as misspelled. How can I add it 
to the Firefox spellcheck dictionary?
Answer: If you are certain that the word is spelled correctly, right-click on the word 
and choose Add to Dictionary.

Question:  I  have  recently  added  some  new  hardware  and  accompanying 
software  to  my  Windows  Vista  computer.  Following  their  install,  I 
occasionally get strange lock-up situations. At first I blamed malware and ran 
scans  with  Spybot  Search  &  Destroy  and  Malware-Bytes  Anti  Malware. 
Nothing was reported by either. What could be the problem?
Answer: It could possibly be untested (by Microsoft) drivers causing the problem. 
You could uninstall the products to see if the problem goes away, or you could use 
Microsoft’s Driver Verifier Manager that is included in Vista. For a more through 
description and a detailed set of instructions see this article by Greg Shultz, writing 
on the TechRepublic blog site: 

http://tinyurl.com/7fpjlh

Question:  I  have  just  set  up  my  Windows  Vista  computer  to  use  Dragon 
Naturally Speaking. I’m having a problem setting the microphone volume to 
a level that the computer can recognize my dictation. How can I adjust the 
setting?
Answer: Go to the Control Panel [and] click on the Sound applet. When the  dialog 

box  opens,  click  on  the  Recording  tab.  Click  on  Microphone  and  click  on 
Properties. Now in the dialog box that opens, click on the Levels tab. Adjust the 
levels  to  suit  your  situation.  Click  OK,  OK,  OK.  Make  sure  that  your  voice  is 
recorded in a manner that is satisfactory. If not, repeat the process. Since I don’t 
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use a microphone, I can’t suggest settings for the levels.

Question: I have a new computer with Windows Vista Home Premium. How 
can I use TweakUI?
Answer:  Bluntly,  you can’t. It isn’t compatible with Vista. Even though I haven’t 
used it you can try the new TweakVI. You can download it here: 

http://tinyurl.com/3hmz8l
A suggestion for you. If  you use it,  please write a review for publication in this 
newsletter.

Question: Last week at the Club’s Question & Answer session, someone asked 
about Revo Uninstaller. As I wasn’t paying attention, what is it, or was it?
Answer:  It is a program that is presumably capable of uninstalling programs that 
the  operating  system’s  Uninstall  function  cannot.  This  is  usually  caused  by 
corrupted  installation  files.  You  may  experience  this  when  trying  to  install  an 
updated version and the installation comes to a grinding halt due to the corrupted 
file. The situation is that you can’t install it, so that you can uninstall it. I normally 
use the Windows Installer CleanUp Utility to address  this problem (don’t use it for 
Microsoft Office 2007).

http://support.microsoft.com/kb/290301
However,  when using  the  Windows Installer  CleanUp Utility  be  careful  only  to 
process the program against  the specific program that is causing the problem.

  “Be aware  that  Windows Installer  CleanUp Utility  will  not  remove  the 
actual program from your computer. However, it will remove the installation 
files  so that  you can start  the  installation,  upgrade,  or  uninstall  over."  -- 
Microsoft KB Article 290301.

With all of that stated, the description of the Revo Uninstaller certainly makes one 
believe that it may be just the ticket. You may download it here: 

http://www.revouninstaller.com/
I haven’t used it, so I can’t say how easy it is to use, nor can I attest to its reliability 
and safety.

Question:  I  have  just  begun using  Microsoft  Office  Outlook  2007.  I  have 
entered all of my contacts and want to start a group listing my contractor 
contacts.  I  can’t  seem  to  create  a  group.  Can  you  answer  in  “blonde” 
language please?
Answer: Lets  start  by  calling  the  “groups”  by  their  correct  name:  “Distribution 
Lists”.  Open  Outlook,  choose  New> Distribution  List  from the  File  drop-down 
menu. Then place the name of your distribution list in the Name: field. Then click 
on the Select Members icon on the task bar.  Enter the name of a contractor in the 
Search box. When the contractor that you want appears and is selected, press Enter 
on the keyboard. Without doing anything else, start typing the name of the second 
contractor that you wish to place in the list.  When the contractor appears again 
press Enter on the keyboard. Repeat as desired. When finished, click OK. Now click 
on the Save and Close icon on the taskbar. Outlook will allow hundreds or even 
thousands (I really don’t know the max) of contacts  in a single distribution list. 
However, your ISP (check with your ISP), or the receiving server owners, i.e., AOL 
and Yahoo, might shut you down for spamming.

Question: Do you recommend a program to optimize PC operations? I saw 
one yesterday (RegCure) that found a bunch of "so called errors" when I ran 
step one. Before I pay money and have it auto fix these, I thought I would get 
an opinion on the program. I presume that you have one, can you let me 
know?
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Answer: The majority of Microsoft MVP (Most Valuable Persons) recommend using 
no Registry programs. I haven’t heard of RegCure, but if it found a slew of errors, 
and you must buy it to remove them, it is not a valid product in my mind and I 
would  avoid  it  like  a  plague.  This  quote  is  typical  of  posts  on  the  various 
newsgroups and forums:

       ”...I got Reg Cure and all it did was take my money. No difference in the 
performance of my machine at all! My wallet is emptier by $29.00 and geting 
[sic] ahold of the company that makes it is impossible unless you want to 
snail mail them in Canada….”

Included in the list of don’t install are:
 RegSeeker
 Registry Mechanic
 WiseCleaner

I generally will run CCleaner only when all other methods of fixing a computer has 
brought me to the point of reinstalling the Operating System (a basket case), a very 
long and tedious project. On some computers, CCleaner worked. However, from 
the computers that I have worked on during the past few months, I would guess 
that your computer is suffering from lack of adequate RAM memory. With Windows 
XP and Service Pack 3, the minimum recommended RAM is 512MB. If you have less 
than that, I suggest installing additional memory sticks. ….

Question:  I  have  a  new computer  with  Windows Vista  Home Premium.  I 
would like to clean up the  “crap” that is installed. I wonder if CCleaner is the 
correct program for this?
Answer: As stated above,  the only time I use CCleaner is on a computer that has 
been  declared  a  basket  case  and  must  have  the  operating  system  restored  to 
Factory-shipped condition. CCleaner is intended to clean off left-over fragments of 
unused programs that didn’t uninstall correctly, clean up accumulated temporary 
files, etc.  It was not intended to clean up a clean, as-shipped, computer. A new 
computer will have none of that.

Some things that I usually do for a new computer setup as a House Call 
volunteer (I do this at home when the  member will allow his/her new toy to be 
taken away):

1. Uninstall Adobe reader versions older than  Version 9.
2. Install Adobe Reader  Version 9
3. If  the  user  has  no  intention  of  paying  for  the  60-day  trial  version  of 

Microsoft Office,  I recommend that it be uninstalled. I will suggest that 
OpenOffice.org be installed as it has virtually the same function with no 
cost.

4. If  the user wants to continue using Microsoft  Office,  I  set up Windows 
Update to include “other Microsoft updates.”

5. If  the  user  agrees  to  the  installation  of  OpenOffice.org,  then  I  also 
uninstall Microsoft Works, if present.

6. With the user’s permission, I uninstall the Internet Security program that is 
included, whether it is Norton, McAfee, Trend Micro or what, and install:
a.     AVG Anti Virus/Anti Spyware 

http://free.avg.com/ 
(there will  be many attempts  to get you to buy the priced version, but 
don’t fall for it.)
b.     With Windows Vista and a router/firewall no other security software is 
needed in a home environment (Windows Defender is included).
c.      Note:  If  Norton  has  been  uninstalled,  I  always  run  the  Norton 
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Removal Tool:
 http://tinyurl.com/czn3ww

d.    If McAfee has been uninstalled, I always run the McAfee Removal Tool:
      MCPR.exe – http://tinyurl.com/mzk9

7. There is a program called PC Decrapifier that will quickly list items that 
could/should be removed and will  do so without further work on your 
part; AOL, Games, Yahoo Toolbar, Google Tool bar, etc. 

http://www.pcdecrapifier.com/node/159 
   You will want to check the list to make sure that you want all of the items 
   offered to be removed.

8. I also download and install the latest iTunes and QuickTime from Apple. 
http://www.apple.com/downloads/

Question: A couple of months ago, you suggested that I use Windows Mail for 
my news reader. Now when I open Window Mail I get my e-mail messages. I 
would  rather that they are downloaded from the server into Microsoft Office 
Outlook. How can I change this undesirable action?
Answer: Open Window Mail, choose Accounts from the Tools drop-down menu. 
Click on the e-mail account and choose Remove. Click Close.

Question: On my Windows XP computer with all updates applied, Outlook 
Express  doesn’t  work  with  AOL and Hotmail.  What  e-mail  programs does 
Outlook Express work with?
Answer: First,  AOL  and  Hotmail  are  not  e-mail  programs.  They  are  more 
appropriately called e-mail services. Outlook Express works with any e-mail service 
that  supports  POP,  IMAP  and  SMTP  mail  protocols.  Outlook  Express  supports 
Microsoft’s proprietary HTTP/WebDAV protocol. However, that is being phased out 
and replaced with Microsoft’s Proprietary HTTP/Deltasync mail protocol. 

Outlook Express has been unsupported as a dead product for the past six 
years. That is why it is no longer bundled with Internet Explorer 7.

Question: I  use Windows Vista Ultimate. I  have never turned off  the User 
Access Control feature. However, I have noticed recently that I have a Yahoo 
Tool Bar on my Internet Explorer browser. I have never clicked “Continue” to 
allow its installation. How did that resource hog get installed?
Answer: The human engineering folks have been at it again. You, among hundreds 
of thousands of others, didn’t notice the little check box, that said to install it on 
installing  an update  to Java.  Even if  you don’t  notice  it,  the  Yahoo Tool  Bar  is 
installed with your OK. When making house calls for your Computer Club [I have 
found that] most member’s have never used the Yahoo Tool Bar, or the Google 
Tool Bar for that matter. If you don’t use them, their overhead when opening your 
browser is wasted. 

To remove them in Windows XP, go to the Control Panel, click on the Add 
or Remove Programs applet, scroll down to either program, select it and click on 
the Change/Remove button. On Windows Vista, go to the Control Panel, click on 
Programs and Features apple and scroll to the program, click on it and then click 
on the word Uninstall. Follow the dialog box prompts.

Question: I have a friend with Windows Vista Home Premium. She says that 
she can’t find the Disk Defragmenter program. I am still using Windows XP. 
What can I tell her?
Answer:  Windows Vista defragments the disk whenever the system is  idle.  Your 
friend doesn’t need to do anything regarding disk fragmentation — ever!
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Question: I have QuickBooks Pro 2007 on my Windows Vista Home Premium 
computer. I have started to operate my company in a second country and of 
course   have to deal with multiple currencies. How can I handle this?
Answer: First order or download QuickBooks Pro 2009. This is the first domestic 
release  to  enable  multiple  currencies.  Second,  because  this  feature  will  be 
absolutely new to QuickBooks users, there is a QuickBooks Simple Start Wiki.

http://tinyurl.com/b49c2u
The site begins with a statement: “...This wiki is your area to learn and share your 
knowledge with others. Think of the wiki as a practical user manual, one that is 
written by small business owners and people who use QuickBooks every day….”
In other words, write our manual for us. Certainly a big difference from the days 
when the software manufacturer published large manuals that were shipped with 
the products, that later found their way into the landfills around the world.

Initially, the manuals were replaced by the Help functions included with the 
various software distributions. In  my opinion, the Wiki will eventually find its way 
into the Help functions, but in the meantime, the Wiki is the way to go. Intuit has 
had great success with its QuickBooks forums by dumping its service work on the 
backs of volunteers that provide thousands of helpful answers to users questions 
annually.

Question: My computer is beginning to slow down. This happens only when 
opening Microsoft Office Word 2002. I write about 3,000 words a day. At the 
present time I have over 1,000 documents which range in size from about 25 
KB to over 20,000 KB. 99% are not actively used. Otherwise, my computer is 
a whiz. My question: is this slowness caused by too many large files?
Answer: No. You didn’t state the size of your hard drive and more importantly the 
amount of unused space on that drive. The reason that I mention that is that I can 
think of only a few things that might be causing your problem:

1) Installed RAM is less than 1GB,
2) A lack of hard drive space may be limiting your Virtual memory, and 
3) you may need to defragment your hard drive. 

If you haven’t backed up your documents to an external hard drive, do it as soon as 
you possibly can. Happiness is a recent backup —when your computer fails.

-----ooOoo-----

What shall I do with my old computer?

Bill Hart

The question came up at a recent club meeting: how should I best dispose 
of  old  computer  equipment?  There  are  small  quantities  of  valuable  metals, 
poisonous materials  and other things in most of our machines. If you still  use a 
cathode  ray  tube  for  your  monitor,  it  contains  highly  poisonous  fluorescent 
materials inside, which make it dangerous simply to smash it with a hammer and 
crush it into your garbage can. Many towns now have special  days set aside for 
collection of hazardous waste, which can include our rejected equipment as well as 
old paints,  oils,  varnishes and the like. So you could simply stack everything up 
until the next time your town has one of these days. I have also been known to take 
old machines down to the town dump and leave them on one side, where when I 
did this I found several others already present, along with old television sets (which 
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may well be clogging our facilities shortly, now the transmission technique has been 
altered by law). I assume these will be passed on to the right place for recycling, not 
simply planted in some dumpsite in the forlorn hope that they will sprout.

But it can happen that what we no longer consider usable could, with maybe 
a little tweaking, make a wonderful present for somebody else. At one time this club 
had an annual auction at which we could get rid of our junk; but it turned out after 
a few years that we were all pretty well on the same wavelength as far as junk was 
concerned, so there were many sellers and no buyers – not a good prerequisite for 
an auction. Also they were AUCTIONS, which implied that what was on offer was 
worth something to other members.

So forget auctions. How about donating your old machine? The Westchester 
PC Club has, very commendably, a group of volunteers who will accept unwanted 
(fairly  recent)  computers,  check  them out,  refurbish  where  necessary,  and  give 
them to charities and other deserving souls. The box below contains part of the 
announcement on their website; visit it at 

http://wpcug.org/index.html#PC Renew.

At the meeting somebody also said that the Danbury Club performs a similar 
service. I asked anyone with ideas or information to send it to the Voice so that we 
could write this article; I got a few responses, but nothing on Danbury. And my 
attempts to learn more by visiting the Danbury website, www.dacs.org, have so far 
proved fruitless. So I cannot confirm this story.

Dick  Booth  read  a  story  in  the  Norwalk  Citizen  and  sent  the  following 
quotation from their issue of 22 May:

“If you have computers and/or peripherals outdated due to upgrading 
that you wish to donate contact Computers for Guatemala that provides 

Westchester PC-Renew 

A project of WPCUG: we rebuild used computers and provide them free to 
groups in the community who can't afford to purchase new ones.
HOW CAN YOU HELP?
1.Donate  Your  Old  Equipment. We need donations of used computers 

with  at  least  a  1GHz  Pentium  III  or  equivalent  AMD 
processor.  We  provide  an  IRS  tax  letter  for  your 
contribution. Call to learn if we can take your computer 
and arrange for a drop-off.
2.  Donate  Your  Time. You can also donate time. You 
don't have to be a computer  expert,  but you must be a 
member of WPCUG. Come to Stepinac High School, 950 

Mamaroneck Avenue, White Plains, in the basement Electronics Lab. Learn 
how to rebuild computers. We'll teach you. The times and dates are in the 
calendar section and you can find a map here. 
HOW CAN WE HELP YOU? Get a Refurbished Computer. If you are a 
Public or not-for-profit organization you should use this application to let us 
know how we can help you..
NEED TO CONTACT PC RENEW? Call 914-946-5511, ext. 2
 or e-mail (wpcrenew@optonline.net) for more information.
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computers for the education of Maya Children.
Call Donald Livingston at 202-655-2362 or visit this website:
www.computersforguatemala.org or email: livy5300@aol.com”

The Make-a-Wish Foundation will  also accept  computers,  though a  quick 
reading seems to show that they are only interested in new ones, which may not 
answer  your  needs.  Anyway,  there  is  only  one location  for  this  organization in 
Connecticut (website www.ct.wish,org):

Make-a-Wish Foundation® of Connecticut
126 Monroe Turnpike,
   Trumbull, CT 06611 

Phone: (203) 261-9044 Fax: (203) 268-2168 
Toll Free: (877) 203-9474 E-Mail: conn@ct.wish.org

and to donate a computer the site is http://donate.wish.org/donate/computer.
With  a  leaning  to  the  business  disposer,  National  Computer  Liquidators 

(www.nationalcomputerliquidators.com) can be reached at 877-625-4872. They 
say

“Our  contribution  to  saving  the  environment  is  something  that  is  of 
utmost importance to National Computer Liquidators. While our main 
focus  is  purchasing  used  equipment  from  large  companies,  what 
happens to the unusable equipment is critical as well.
“All equipment we receive is resold, donated or recycled. When we say 
computer recycling we mean it. Equipment that has no value is actually 
shredded and then separated into its most basic component materials 
that will then be refined and reused to make new products. Nothing is 
sent to landfills or put back into the environment in a hazardous way.”

So if you want to be sure your equipment will be properly recycled you could do 
worse than see if they are interested in your small offering.

Computers  With  Causes  (www.computerswithcauses.org) will  accept 
donations over the Internet. Exactly how that works I leave you to discover. Check 
it out.

The EPA has information on proper disposal and facilities at each state. 
Look  at  www.epa.gov/waste/conserve/materials/ecycling/index.htm for  more 
than  you  ever  wanted  to  know.  And  they  have  a  page  specifically  designed  to 
answer the question, emblazoned across its top, 
“Where Can I Donate or Recycle My Old Computer and Other Electronic Products?”
It is at www.epa.gov/waste/conserve/materials/ecycling/donate.htm

Since this has more information than I could ever get into a single article 
in the Voice, I suspect this is as good a point as any to stop and let you browse on...

-----ooOoo-----
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Tidbytes
INUX continues to improve. If you want 
to try it, one version to aim for might be 
Mandriva  2009  Spring,  at  www. 

Mandriva.com/en/download/free.  You  have 
an  immediate  decision  to  make:  KDE4  or 
Gnome.  Choose  KDE4 for  a  GUI  display  not 
unlike  Wndows,  which  should make  you  feel 
more at  home.  Or be more adventurous and 
choose Gnome. Either way, you will download 
a CD-size ISO file. Burn it to a CD, then boot 
from that and you can test Mandriva Linux  without affecting your hard drive! It 
won't be the fastest system on the block run this way, because everything has to 
found on the CD, but it will be able to do everything the installed version does, 
AND it can be installed via an icon on the desktop if you want to (but be prepared 
to release some disk space for this, of course).

L

ne reason I mention this version: run it on your laptop and you should be 
able to use WiFi to connect to your router, as you can with Windows these 
days. I have it on mine, and it is a lot safer on the Internet than any version of 

Windows. Have fun!

O
H, I forgot: Linux will set up a dual-boot multi-loader for you if you do install it. 
Here's a picture of my laptop initial screen, for example:
O

My HP laptop runs Vista Home Premium, and Vista has a built-in program to release 
disk space and create more partitions.  
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I went to Control Panel | System and Maintenance |Administrative Tools | 
Computer Management | Disk Management, and set up two new partitions, one 
about 4GB and one about 17 GB. With the HP Recovery partition, that made four 
primary partitions, which is  the maximum. The smaller one is used by Linux as 
Swap Space; the larger contains the files.  It may seem small,  but remember that 
Linux can access all your Windows storage space as well, even though Windows will 
not even be able to show you these partitions exist.  So you can save your word 
processor output with your other documents,  for example – those created by a 
Redmond product.

ARNING – Microsoft NEVER send you a patch message with a direct link to 
the  patch.  Instead,  they  give  you  an  address  to  what  Susan  Bradley  of 

Windows Watch refers to as “a bulletin landing page”. Recently hackers have been 
sending false messages about 'patches' to Outlook and Outlook Express, ostensibly 
from Redmond. DO NOT TOUCH THEM! If you do you will end up with some very 
nasty malware. You have been warned.

W

http://windowssecrets.com/comp/090702

-----ooOoo-----

Word Processing Choices from A-Z (really)

 John White

From The November 2008 ICON Graphic, Newsletter of ICON PC User Group, Inc.
www.iconpcug.org

editor (at) iconpcug.org

Besides the venerable Microsoft Word and WordPerfect,  an array of word-
processing applications—both cheap and free—is vast and growing rapidly. Some 
are freestanding singletons to install on the hard disk. Some serve in a suite of apps 
including a spreadsheet to run live via the Internet. Most online versions I viewed 
still manifest hurdles to leap before they reach maturity. Two installable versions of 
MS-Office alternatives, however, rival the Gates products in impressive ways.

Abiword: 
Although Microsoft's “Wordpad” performs at least half of the writing tasks 

most of us do, Abiword is installed on my four Windows computers. It will do 98% 
of what I ask of a word wrangler. Placing a tiny icon on the Quick Launch menu just 
to the right of the Start button provides this fast-loading, capable program in easy 
reach. The native file format, .abw, works equally in Abi's versions for Linux and 
Mac OS X, but there is also an easy drop-down option to save in .doc, .rtf, .txt, 
.html,  .xhtml,  and  other  formats.  Abi  is  a  favorite  alternate  of  some  of  ICON's 
leaders. [Free download: http://www.abiword.com/] The latest version is 2.6.2. 

Buzzword: 
Adobe's  offering, self-described as “The First  Real Word Processor for the 

Web” even though it's not, requires [1] a sign-up and password [2] and says “We're 
sorry, JavaScript must be enabled in order to use Buzzword.” I'm sorry, too. If a 
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program requires JavaScript, ActiveX, Flash, or Internet Explorer, I can live without 
it. The world is dangerous enough without them, and my life is already too exciting. 
Ah, so little time and so many other choices! If someone is willing to deal with it, 
please try it and give us your reaction to Buzzword. [Free download required:
http://www.buzzword.com]

Flysuite: 
This one promotes itself  as  an online alternative to Word and Excel that 

focuses on document collaboration. When I went to their Web site, my Comodo 
firewall filled the lower right quarter of the screen with warnings about “blocked 
URLS,” an all time record. That sounded too much an attack of potential bad guys 
and  I  stopped  right  there.  Any  braver  soul  care  to  report  on  Flysuite?  [Free: 
http://www.flysuite.com]

Google Docs beta: 
A new offline version exists but in an even earlier beta stage: Despite my awe 

for the quality and variety of many offerings from Google, Docs beta online doesn't 
make the list. It seems to drive a middle lane between “lightweight” and “lame.”

I see no reason to use it yet instead of Abiword or even Wordpad to create a 
new file. Any other users care to point out advantages too subtle for me to spot? To 
get there, enter your Gmail account name and password. Click on NEW>Document 
(or spreadsheet, presentation, or folder) and go to work. Don't look for rulers, tabs, 
or even clues about WordArt, mail merge or even clues how to send the document 
as  an email  or  attachment.  A limited  selection of  insertable  “special  characters” 
offers barebones Wingdings but not Monotype Sorts or any other favorite character 
sources.  You  can  insert  other  special  characters  if  you  know  their  Unicode 
numbers.  Oddly  enough,  the  insertable  “Asian”  character  set  includes  angle 
brackets, printer dingbats, Western math symbols, plus cm, kg, km, and copyright 
(c). You may still have to wangle an “invitation” to Gmail if Google is still playing 
hard-to get with this powerful email/storage service. Free: http://docs.google.com.

Microsoft Works: 
Older versions required hop-skip-and-jump trips through menus to reach an 

otherwise inviting word processor with usable templates for home and school use. 
Works  8.5  came on my laptop  a  year  ago,  but  some Vista  machines  reportedly 
include version 9 of Works employing a full version of MSWord although the MS 
Web site was somewhat vague about this. Version 8.5's word processor looks like 
Word Lite. It includes the ability to open its own .wps format and its .wpt templates 
(nice) as well as Word and other formats such as .rtf, .txt, .csv, and .html. Forget 
about .xml, .odf, or MS-Office 2007's own .docx. Works offers a friendly and capable 
database, a spreadsheet, calendar, and dictionary as well. Version 8.5 is under $10 
at http://store.purplus.net/miwo85.html

Mindomo: 
As a preliminary for individual or group writing, this program calling itself 

an “Online Mind Mapping Process” offers a free visual organizer to clarify and plan 
the writing process. Your turn: http://www.mindomo.com/

Notepad: 
The built-in Windows plain-text editor makes a type minimalist HTML editor 

with clean unformatted code.  Not  all  users know there are font and word-wrap 
options available. To check it those capabilities, go to Start|Accessories|Notepad|
Format.
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OpenOffice Writer: 
This article is being written with version 2.4. It retains a few minor quirks 

and inconveniences compared with MS-Word 2000, XP, or 2003 plus some decided 
advantages.  For  example,  if  the  squiggly  red line  under  correctly  spelled  terms 
(missing from its dictionaries) bothers you, UNclick the ABC button on the top of 
the screen—the one with a wavy red line. At any point, click its mate (ABC above a 
blue check mark) and manually check spelling. However, there is not button for the 
thesaurus. Call it up instead with Control-F7. You can also check in Czech or Nepali 
as well as more common tongues. The default language list supplies three flavors of 
English  and  three  of  German  but  none  of  French  or  Spanish.  More  79  other 
language dictionaries are downloadable or under development. I switch between 
OpenOffice (“Writer” or “switer.exe”) and Word, depending on the task. OOW saves 
keystrokes  by  remembering  recently  typed  words  and  inserting  them  in  white 
letters amid blue bands after one types just a few of the word's letters. To accept its 
suggestion after starting a word, tap ENTER and keep typing. To ignore it instead, 
just type on. Users of Excel will recognize and appreciate this option. OpenOffice 
outdoes Word in WYSIWYG cropping of inserted pictures. For a long time OO has 
offered in the File menu “Export as PDF” as one choice at file-saving time. A menu 
button also offers the same feature.  It  rapidly creates and saves the file  directly 
instead of sending it to a printer menu as Adobe's expensive version requires.

Logically  enough,  page  formatting  choices  are  found  in  the  (TA-DA!!!) 
Format drop-down menu instead of the File menu. I especially like the “E-mail as 
Microsoft  Word”  button  on  my  customized  toolbar.  I'll  use  that  one  in  a  few 
minutes to send this file to Ira.

Although a paid-for version with telephone help is  available  as StarOffice 
(from  Sun  Microsystems)  for  under  $70,  this  free  version  is  supported  by  a 
worldwide  community  of  volunteer  programmers  and  forumdwellers.  The  suite 
includes equivalent programs for Excel and PowerPoint, a capable database, and a 
drawing program—all accessible from the File>New menu in OpenOffice Writer. In 
place of Microsoft Publisher in the premium-priced MS-Office suite, the free open-
source Scribus may be satisfactory [http://www.scribus.net/]. The native OOW file 
format,  .odt,  is  widely  employed around the world,  conforming to the standard 
used in Europe and other ISO countries. This file type crosses platforms to work in 
Windows,  Linux,  and  Mac  OS X.  OOW also  opens  and  saves  in  .doc,  .txt,  .rtf, 
.xml, .html, plus several more formats including Microsoft's .psw [for Pocket Word]. 
I have had better success with OOW opening and editing older Word documents 
than with MS-Office 2007. [Free download to install: http://www.openoffice.org/]

Thinkfree Online: 
To me, it's “ThinkLoser.” and forget the “free” part. This is/was supposedly a 

free online suite with an optional Premium version. Reputable media mentioned its 
limited beta offering was as early as December 2006 with cost estimates of $5 to $10 
a month. Earlier this week (April 15) a Web search at Avant listed Broderbund as #1 
among  many  download  sources,  but  that  link  seized  up  both  times  I  tried  it. 
Reaching Broderbund by a different route, I  found the installable (not “online?) 
Windows-only version for $44.95. After 20 minutes or more trying to download, 
register, and fire it up the free one elsewhere on the Web, after email verifications, 
etc., plus two more crashes—amid various notices about what to do if downloading 
and installing failed in a variety of ways—I admitted failure and uninstalled it. Just 
before  giving  up,  I  had  semi-installed  and  managed  to  find  a  Thinkfree  screen 
claiming this to be the best office suite on earth. If so, earth is in trouble besides 
just growing warmer. Other  screens apparently accessed their word processing, 
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spreadsheet,  and  presentation  software,  but  never  revealed  any  way  to  actually 
create  a  file  using  any  of  those  choices!  Two teases  seemed promising  at  first
—“Search” and collaboration. Since I had not yet created a document, it was no 
surprise  that  searching  for  one  proved  to  be  a  dead  end.  With  nothing  yet  in 
production by me or anyone I know, its collaboration had even less utility. Next, I 
searched  in  “Templates,”  achieving  my  only  Thinkfree  success,  sort  of.  I  typed 
“letter” in the template search box and got five letter templates or something. The 
first didn't seem to be a letter template at all, but was a document about how to use 
Haitian  expressions.  The  other  four  were  in  Asian languages  using  characters  I 
cannot  read.  To be fair  to  Thinkfree,  I've  copied  and pasted below their  exact 
message  and  boldfacing.  Since  I  never  reached  the  “Sync  Cache”  folder  they 
describe, I wish you better luck than mine if you care to try it. No date for the new 
version  or  demise  of  the  older  one  was  mentioned.  If  you  have  purchased  TF 
Premium, store  the receipt  with your Enron stock certificates.  Microsoft  needn't 
worry about this competitor. “We will be launching 'My Office' and providing a new 
version of ThinkFree Office. You will no longer be able to use the old version which 
is called 'ThinkFree Premium' as of that time. You will be using our new integrated 
ThinkFree Online service after installation. Please remove 'Sync Cache' folder before 
you  proceed  installing  the  new  version  of  ThinkFree  Office.Location  and 
Instructions for removing the sync folder.

For Windows: C:\Documents and Settings\account\MyDocuments\TFSync
For Mac: /Users/account/Documents/TFSync
For Linux: /home/account/TFSync”

Wordpad: 
This little brother of MS-Word comes free with your Windows installation. It 

opens  and  saves  in  Unicode,  .rtf,  and  the  older  MS-DOS  .txt  format  but  not 
Word's .doc. It comes with bolding, italics,  and underlining of installed Windows 
fonts in colors, a horizontal ruler with adjustable margins and tabs, and a single 
bullet style but no numbering button or mail merge. It is a good emergency word 
processor  if  the  missing  features  aren't  needed  for  the  project  at  hand. 
[Start>Accessories>Wordpad]

WordPerfect X3: 
One  can  pay  the  full  “retail”  price  of  several  hundred  dollars,  but  at 

http://www.royaldiscount.com/corel.html it is $82.94. I prefer the “OEM' version for 
$18.46  with  free  shipping  for  either  version.  The  current  X3  suite  contains  a 
powerful, customizable word processor compatible with MSOffice. Its Quattro Pro 
spreadsheet  matches  Excel  quite  nicely.  A  graphics  drawing  application  and 
Presentations either its native mode or in PowerPoint mode. The word processor 
offers to work in MS-Word style, native WP X3 style, or older versions back to 5.1. 
All these apps play nicely with MS formats. 

Zoho: 
I admit to saving the best for the last. Zoho wins my prize as winner among 

online word  processors.  All  the  integrated application  elements  of  Zoho's  suite 
employ similar enough interfaces and working styles so that users of Office version 
through 2003 will either recognize or master them quickly. I wish Microsoft Office 
2007  had  been  designed  by  Zoho.  This  suite  connects  many  well  presented 
applications in a style that handles like a nimble sports car instead of a ponderous 
“featuremobile.”  It  displays  obvious  buttons  and  tools,  export/publish  options 
(including PDF), offline options (after one installs Google Gears), a stunning array 
of  accessible  and complementary features:  spreadsheet,  blogger,  chat,  notebook, 
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planner,  mail,  database  creator  and  reporter,  conferencing,  wiki  editor,  project 
manager, CRM and contact manager, plus others. Even if “Help” seems a bit elusive, 
the  buttons  and  menus  provide  intuitive  answers  better  than  traditional, 
encyclopedia-type help. I found no reference to mail merge, but the other word 
processing feature set is  both complete and readily at  hand. Spell  check,  tables, 
bulleted lists,  tags as folders,  comments,  and collaboration features seems to be 
exceptionally friendly. I have just started using this impressive suite, so an in-depth 
evaluation will have to wait.

About John White: John has taught word processing and spreadsheets for a dozen 
years at New Horizons (Manhattan), Dowling College, NY Tech, and BOCES.

This  article  has  been  obtained  from  APCUG  with  the  author’s  permission  for  
publication by APCUG member groups; all other uses require the permission of the  
author (see e-mail address above).

-----ooOoo-----
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